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INTRODUCTION 

The Study Guide for Lab Classes is intended to improve the quality of 

teaching students how to learn complex automated control systems of techno-

logical processes and industrial mechanisms. 

The first part of the Study Guide allows you to learn the basic concepts of 

classical theory of linear dynamic systems analysis: 

- transfer functions of typical dynamic control actions; 

- building and learning their time and frequency responses; 

- building simple systems algoritmic block diagrams from typical 

dynamic control actions and research them. 

Study Guide includes the material for preparation and performing of lab 

classes. Every description of the lab class includes the objective of the work, a 

theoretical part, tasks and self-control questions. To perform tasks in lab classes 

applying of MATLAB and Simulink software is recommended. For each lab 

class practical recommendations on performance of tasks and fragments of the 

report are provided. Details you can see in appendixes. 

Lab class 1 «Basic knowledge of MATLAB and Simulink. Building sim-

ple models» is dedicated to introduction to the operational and graphical soft-

ware MATLAB and Simulink software. Main commands and main principles of 

system modeling are overviewed. 

Lab class 2 «Study of time responses of typical dynamic control actions» 

is dedicated to time responses of the linear dynamic control actions to standard 

input signals. The main tools for typical dynamic control actions analysis in 

time domain using Simulink are considered. 

Lab class 3 «Study of the frequency response of typical dynamic control 

actions» is dedicated to frequency response of linear dynamic control actions. 

The features of writing the scripts for each typical dynamic control actions in 

MATLAB to build them frequency responses are considered. 

Study Guide to Lab Classes are for students of specialty 141 «Electric 

Power Engineering, Electrical Engineering and Electromechanics» learning the 

discipline «Theory of Automatic Control. Part 1» on Educational Program in 

English. 
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Lab class 1 

Basic knowledge of MATLAB and Simulink. Building simple models 

Objective of the work: 

– introduction to MATLAB/Simulink;

– learning the base and getting skills in Simulink;

– building of simple models in MATLAB.

1.1 Theoretical part 

MATLAB is a programming and numerical computing platform for data 

analysis, develop algorithms and create models. 

Simulink is MATLAB application for modelling dynamic systems. You 

can create models using block diagrams from the standard block library and 

perform calculations. During simulation, you can observe transient responses 

that occur in the system. Special observation devices, which are included in the 

Simulink standard block library, are used for this purpose. The results of the 

simulation can be presented in the form of graphs or tables. 

Run Simulink 

To run Simulink, MATLAB must be started first. To start it, double left-

click on the MATLAB icon. When MATLAB is started, the MATLAB Com-

mand Window opens as shown in Figure 1.1. 

When MATLAB Command Window is open, you need to run Simulink. 

There are three ways to run Simulink: 

– click Simulink button  on MATLAB toolbox (number 1 in Figure 

1.1); 

– type Simulink on your keyboard in MATLAB Command Window and

press Enter (number 2 in Figure 1.1); 

– click Open on the File menu (number 3 in Figure 1.1) and open a model

file with the extendent .mdl, for example, my_lab.mdl. 

After starting Simulink, the Simulink Library Browser window opens 

and shows the list of standart block libraries in hierarchical structure. The Sim-

ulink Library Browser window is shown in Figure 1.2. 
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Figure 1.1 – MATLAB Command Window 

Figure 1.2 – Simulink Library Browser Window 
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Figure 1.2 uses the following notations: 

1 – MATLAB Command Window toolbox with command buttons is the 

most commonly used; 

2 – Comment window to display an explanatory comment about the se-

lected library subpart or block; 

3 – list of library blocks: 

 Continuous – Model linear functions;

 Discontinuities – Model nonlinear functions;

 Discrete – Model discrete functions;

 Look-Up-Table – Approximation and interpolation blocks;

 Math Operations – Model mathematical and logical functions;

 Model Verification – Checking the adequacy of the model;

 Model-Wide Utilities – Utilities (tuning) of the model as a whole;

 Port & Subsystems – Subsystem input (output);

 Signal Attributes – Properties of signals;

 Signal Routing – Distribution of signals;

 Sinks – Display or export output;

 Sources – Generate or import system inputs;

4 – list of library subparts or nested blocks; 

5 – status bar that contains a prompt for the taken action; 

6 – address bar to find a block icon 

To find the specific block, you can use automatic search by name. Write 

down the name in address bar to find a block icon 6 (some letters are possible) 

and press Enter. After that, the automatic search block starts. If the block is 

found, it is displayed in the list of nested blocks 4 as selected. 

Create a new file and Simulink model 

To creat a new block diagram in the Simulink, you should open a window 

Simulink Editor. From the Simulink Library Browser menu, select File  

New  Model or click Create a new model  on the Simulink toolbox. It 

opens an Untitled window (highlighted by the ellipse in Figure 1.3), where the 

blocks from the Simulink Library Browser subpart are moved, making up the 

block diagram. 
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Figure 1.3 – Untitled Window from the Simulink Library Browser, 

where making up the block diagram. 

An existing Simulink model from the Simulink Library Browser menu is 

opened with File → Open or by clicking Open a model  on the Simulink 

toolbox. Select the model file that you want to open and then click Open. The 

selected model opens in the Simulink Editor. 

To build a model, need by copying or draging blocks from the Simulink 

Library Browser to the Simulink Editor. To place blocks in the Untitled win-

dow, open the specific subpart of the Simulink Library Browser, then select the 

specific block and drag the block from the Library Browser to the Simulink 

Editor model window. 

Figure 1.4 shows that Sources library is selected in Simulink Library 

Browser in the left pane (number 1 in Figure 1.4). The right pane of Simulink 

Library Browser displays icons from the selected library. Select the Clock icon 

(number 2 in Figure 1.4). Place the cursor on it, press and hold down the left 

mouse button and move this icon to the created Untitled window. Then release 

the left mouse button. Therefore, the Clock as the block has moved to the Untit-

led window (shown by the arrow in Figure 1.4) 
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Figure 1.4 – Moving the Clock as the block from the Simulink Library Browser 

to the Untitled Window  

Add other blocks to your model using the same way as for adding the 

Clock block. Now you have the blocks to build a simple model. 

Blocks in the Untitled Window can be copied. To do this, highlight this 

block, press and hold the left mouse button, and then drag this block to where it 

will be in the Untitled Window as shown in Figure 1.5. 

Figure 1.5 – Adding and copying blocks from Simulink Library Browser 

to Untitled Window 
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A number is added to the new block name. After copying, all the blocks 

can be spreading all over the Untitled Window. Therefore, they should be locat-

ed in such that they can be easily connected, as shown in Figure 1.6. 

Figure 1.6 – Location of blocks to connect them in an Untitled Window 

To connect the blocks together, need to draw connecting lines between the 

output and input ports. The input and output ports of some blocks are shown in 

Figure 1.7: the Clock block has an output port and no input port, the To Work-

spase block has an input port and no output port, the Transfer Fcn block has an 

output and input ports. 

Figure 1.7 – The input/output identification of some blocks 

There are two ways to connect blocks: 

• manually;

• automatically.



11 

An example of a manual connection of two blocks together is shown in 

figure 1.8. 

а b 

Figure 1.8 – Connecting the two blocks manually 

To do this, place the cursor on the output port of the first block (Constant 

block). The cursor changes to a cross (+) (Figure 1.8,а). Press and hold the left 

mouse button and drag the cross from the output port of the Constant block to 

the input port of the next block (Scope block). While you hold down the mouse 

button, the connecting line is shown as a red dashed arrow. When the cross is 

over the output port release the left mouse button (Figure 1.8,b). If the connect-

ing line is a solid black arrow, it means that the blocks are connected. If the 

connecting line is a dashed red line, it means that the blocks are not connected. 

To connect the two blocks together automatically, place the cursor on the 

first block (Constant block) and right-click. Black markers will appear in the 

corners of this block. Next, press and hold down the Ctrl key, position the cur-

sor on the second block (Scope block) and right-click. A connecting line will 

draw. 

Figure 1.9 shows an example of a manual connection of three blocks. To 

connect three or more blocks, you must first connect two blocks together. 

To connect the input port 

of the third block (Display 

block) to existing connecting 

line, a branch point must be 

created. To create a branch 

point in a connecting line (i.e. 

a take-off point), need to place 

the cursor where you want to Figure 1.9 – Connecting the three blocks manually 
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start a branch line. Click, and then drag the cursor away from the line to form a 

dotted-red line. Next, drag the cursor to the anothe input port (Display block), 

and then release the mouse button. 

So, Simulink connects all the blocks togather with connecting lines. They 

transmit signals in the direction indicated by the arrow. The lines must always 

transmit signals from the output port of one block to the input port of another 

block. On exception to this is a line may branch point from another line, split-

ting the signal into two blocks. 

Setting and changing datas 

When the blocks are connected, need to set the data for each block. Dou-

ble left-click the block icon opens the Block Parameters dialog box (highlighted 

by the ellipse in Figure 1.10). 

Figure 1.10 – Setting and changing datas in the Block Parameters TransferFcn 

If you enter data as a letter, the numeric values need to set in the 

MATLAB Command Window or in the script before you start the simulation. If 

you enter the data as a decimal, the whole number part and fractional part are 
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separated by a decimal point, not a comma. Then close the Block Parameters 

window by pressing OK or Apply. 

Selecting model components 

To perform any action with a model components (block, connecting line, 

inscription), them must be selected. To do this, place the cursor on the model 

component you want to select and right-click. Black markers will appear in the 

corners of the model component. 

To select some model components, place the cursor near the group of 

model components. Press and hold down the right mouse button, drag it. A dot-

ted line will appear and resize as you move the mouse. All framed model com-

ponents become selected. You can also select some model components with the 

Edit  Select All command. 

A selected model component can be copied, moved to the clipboard, past-

ed from the clipboard and deleted. 

Copy and move model components to the clipboard 

To copy a model component, you need to select it. Then left-click and 

hold down the left mouse button and drag it. A copy of the model component is 

created, which you can drag to the place you want. 

To copy the block to the clipboard, you need to select it, click the Edit  

Copy from the menu or by clicking Copy  button on the toolbox. 

To copy the model to the clipboard, select it and using the Edit  Copy 

model to Clipboard move the model image on the Windows clipboard and 

make it available to other applications. 

Paste blocks and Simulink model from the clipboard 

To paste a block or Simulink model from the clipboard, left-click any 

place in Untitled Wimdow. Click the Edit  Paste command from the menu or 

by clicking Paste  button on the toolbox. 

Delete model components 

To delete model components, you need to select them, click the Edit  
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Clear command from the menu or by clicking Delete on the keyboard. 

Pay attantion that the Clear command deletes the model components with-

out moving them to the clipboard. 

 

Resize blocks 

To resize a block, you should 

select it. Place the cursor on one of 

the black markers in the corners of 

the block.The cursor changes to a 

double-sided arrow, left-click and 

expand (or compress) the block 

image, as shown in Figure 1.11.   
 

Figure 1.11 – Resizing blocks 

 

Move blocks 

To move block, you need to select it, click and hold down the left mouse 

button. Connecting lines between the input port of one block and the output port 

of another block can decrease or increase in length, but not break. 

It is also can insert any block into a connecting line between already con-

nected blocks. To do this, select the block, click and hold down the right mouse 

button. Drag this block to the desired location on the connecting line. 

 

Setting Simulation Parameters and run Simulation 

Before you run Simulation the behavior of a block diagram, set the simula-

tion parameters. Click the Simulation  Simulation Parameters… command 

from the menu Untitled Window. It opens the Simulation parameters: Untitled 

window to the Solve pane, as shown in Figure 1.12, where you can set the type of 

numerical solver, start and stop times, and maximum step size. 

The simulation time is set in the Start time and Stop time fields. In the 

Start time field, enter zero, and in the Stop time field, enter a user-defined num-

ber depending on task conditions. 

In the Type field need to select: the integration step as variable-step and 

integration method as ode45 (Dormand-Prince). These parametrs use for the 

continuous-time systems simulation, which are considered in the disciplin 

«Theory of automatic control. Part 1». 
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Figure 1.12 – Simulation Parameters Window 

 

In the Max step size field, set the maximum integration step 
іnt

t . The de-

fault setting is auto. If this is the case, the transient responses will be as broken 

lines. To make the transient responses smooth, the integration step need to cal-

culat by the formula 
10

min
іnt

T
t  , where Tmin is the minimum time constant of 

the system. Then close the Simulation Parameters Window dialog by pressing 

OK or Apply. 

After setting Model Simulation Parameters, you can run the simulation 

your model and study its behaviour. To do this, click the Simulation  

Simulation Start command from the menu Untitled Window or by clicking 

Start Simuation  button on the toolbox. The simulation runs, and then stops 

when it reaches the stop time specified in the Model Simulation Parameters 

dialog box. 

 

Save the block diadram and script as a file 

The created block diagram and script need to save to disk as a file. To do 

this, click the File  Save As... command from the menu. The Save As... menu 
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is opened, where you need to select the folder and write the file name. If you 

want to save the block diagram, the file will have the extension «.mdl». If you 

want to save the script, the file will have the extension «.m». 

The file name must starts with a letter and cannot exceed 32 symbols. The 

file name cannot contain Cyrillic and other special symbols.  

If you want to save the file again, use the File  Save command from the 

menu. 

 

1.2 Tasks 

1. Study Simulink and basic concepts. 

2. Run Simulink. 

3. Create the Simulink model named Untitled. 

4. Open the Simulink Library Browser. 

5. Build the block diagram and locate its blocks as shown in Figure 1.13 

 

 
Figure 1.13 – Block diagram for studying the Gain block with different input signals 

 

5.1. To build the block diagram, first open the Simulink/Sources library. 

Find and move the input signal icons from the Simulink Library Browser to the 

created Untitled Window, as shown in Figure 1.4 and set block data in the 
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Block Parameters, as shown in Figure 1.10. 

The input signals applied to the Gain block to study its behavior from 

Sources library: 

– the Clock block (time signal) outputs 

the current simulation time at each simula-

tion step. The Clock block icon is shown in 

Figure 1.14; 

 
Figure 1.14 – Clock block icon 

– the input signal, the unit step function increases instantly from zero to 

one and remains unchanged, as shown in Figure 1.15,a. 

The unit step function is described by the equation x(t) = 1(t) and is set by 

the Constant block. The Constant block icon is shown in Figure 1.15,b. 

Enter 1 in the Constant value field of the Block Parameters: Constant, 

as shown in Figure 1.15,c: 

 

 

 

a 

 

b c 

Figure 1.15 – Unit step function, its icon as the Constant block 

and setting data in the Constant block 

 

– the input signal, the linearly increasing signal starts at a specified time 

and changes by a specified rate, as shown in Figure 1.16,a. 

The linearly increasing signal is described by the equation x(t) = 1·t and is 

set by the Ramp block. Ramp block icon is shown in Figure 1.16,b. 

Set the data in the Block Parameters: Ramp as shown in Figure 1.16,c: 

 the rate of change of the output signal in the Slope field, enter 1. This 

corresponds to the angle of the signal to the abscissa axis with an angle of 45º; 
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 the start time in the Start time field, enter 0; 

 the initial output signal level in the Initial output, enter 0: 

 

 

 

a 

 

b c 

Figure 1.16 – Linearly increasing signal, its icon as the Ramp block 

and setting data in the Ramp block 

 

– the input signal, the unit impulse function is a rectangle with an area 

equal to one, S = 1. The amplitude of the rectangle tends to infinity, A , 

the width its tends to zero, 0 , the period its tends to infinity, T , as 

shown in Figure 1.17,a. 

The unit impulse function is described by the equation    ttx   and is 

set by the Pulse Generator block. The Pulse Generator block generates square 

wave pulses at regular intervals, as shown in Figure 1.17,b. Its icon is shown in 

Figure 1.17,c. 

 

 
 

 

a b c 

Figure 1.17 – Unit impulse function and its icon as the Pulse Generator block 
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Set the data in the Block 

Parameters: Pulse Genera-

tor, as shown in Figure 1.18: 

 in the Amplitude 

field, enter 100 or another 

value; 

 in the Period (secs) 

field, enter 100 or another 

value; 

 in the Pulse Width 

(% of period) field, enter the 

number calculated using the 

formula: 

T

τ 100%
(%)


WidthPulse , 

where 
A

1
  – is pulse width, 

  T – is period. 

 

Figure 1.18 – Setting data in  

the Pulse Generator block 

 Phase delay (secs) is set to 0 in this laboratory work. 

 

– the input signal, the sinusoidal signal, whose wave amplitude is one, 

A = 1, angular frequency is one, ω = 1, initial phase is zero, φ0 = 0, and wave 

offset is zero, φ = 0, as shown in Figure 1.19,a. 

The sinusoidal signal is described by the equation   ttx sin1)(  and 

is set by the Sine Wave block. Sine Wave block icon is shown in Figure 1.19,b. 

 

 
 

a b 

Figure 1.19 – Sinusoidal signal and its icon as the Sine Wave block 
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Set the data in the Block 

Parameters: Sine Wave, as 

shown in Figure 1.20: 

  in the Amplitude field, 

enter 1; 

 in the Bias (wave offset 

) field, enter 0; 

 in the Frequency 

(rad/s) (angular frequency ), 

enter 1; 

 in the Phase (rad) (ini-

tial phase 0), enter 0. 

 

5.2. The Gain block you 

are studying is described by the 

transfer function K. It can be 

found in the Simulink/Math 

Operations library. Gain block 

icon is shown in Figure 1.21,a. 

In the lab class, the trans-

fer function K is set in three var-

iants: 

 
2

1

N
K  , where N is 

the variant number correspond-

ing to the number in the list of 

group students; 

 K2 = N; 

 NK  23 . 

Enter K in the Gain field 

of the Block Parameters: Gain, 

as shown in Figure 1.21,b, for 

the corresponding Gain block in 

Figure 1.13. 

 
Figure 1.20 – Setting data in the Ramp block 

 
a 

 
b 

Figure 1.21 – Gain block icon and setting data in it 
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So, the block diagram you are studying has four input signals and three 

Gain blocks with different transfer functions K. In the lab class you should 

study the response of each Gain block to the given input signals one after the 

other. For this, select one of the four input signals and one of the three Gain 

blocks and connect them together through the Manual Switch block. 

 

5.3. The Manual Switch block can be found in the Simulink/Signal Rout-

ing library. Manual Switch block icon is shown in Figure 1.22. 

Find and move the Manual Switch block 

icon from the Simulink Library Browser to the 

created Untitled Window. Сonnect all the blocks 

together with connecting lines between the out-

put and input ports, as shown in Figure 1.13. 

 
Figure 1.22 – Manual Switch 

block icon 

To toggle between the selected input signals and the selected Gain blocks, 

double-click on the Manual Switch block. 

So, you indicate which input signal feeds the Gain block's input. The 

study results are written to MATLAB workspace using the To Workspace 

block. 

 

5.4. The To Workspace block can be found in the Simulink/Sinks library. 

To Workspace block icon is shown in Figure 1.23. 

Find and move the To Workspace block 

icon from the Simulink Library Browser to the 

created Untitled Window. Connect the To 

Workspace blocks together with the connection  

 
Figure 1.23 – To Workspace 

block icon 

lines between the output ports of the Clock block and the Manual Switch block, 

as shown in Figure 1.13. 

Set the data in the Block Parameters: То Workspace, as shown in Fig-

ure 1.24: 

 in the Variable name field, enter the name of the variable whose data is 

saved to the clipboard. In the lab class, the block diagram in Figure 1.13 has: 

– input signal name is x. Therefore, in the Variable name field, enter x;  

– output signal name is y. Therefore, in the Variable name field, enter y;  
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– the time signal name 

is t. Therefore, in the Variable 

name field, enter t; 

 in the Save format 

field, select Array. In Array 

format, the data is saved as an 

array in which the number of 

rows is determined by the 

number of calculated points in 

time and the number of 

columns by the dimensionality 

of the vector that is fed to the 

block input. If the input is a 

scalar signal, the array will 

contain only one column. 

 
Figure 1.24 – Setting data in the То Workspace Block 

So, the block diagram in Figure 1.13 is created. 

 

6. Copy the created block diagram to the clipboard as described in the 

Theoretical part: Copy and move model components to the clipboard. 

7. Open a Word Document and paste the created block diagram from the 

clipboard using the Edit →  Paste command from the menu or by clicking Paste 

 button on the toolbox in Word Document. 

8. Set the simulation parameters as described in the Theoretical part: 

Setting Simulation Parameters and running simulation. 

9. Save the created block diagram as described in the Theoretical part: 

Save the block diagram and script as a file. 

After saving the block diagram, study the behaviour of the Gain block 

with different values of transfer ratios K to the given input signals x(t): 

– the unit step function; 

– the linearly increasing signal; 

– the unit impulse function; 

– the sinusoidal signal. 

10. Study the behaviour of the Gain block with transfer ratios K1, K2 and 

K3 for each input signal type x(t) separately. For this, switch the Gain blocks 
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one after the other using the Manual Switch block. 

Run simulation after each Gain block switch by clicking Start Simuation 

 button on the toolbox. 

11. Plot the transient responses of the input x(t) and output y(t) signals in 

the same coordinate axes. For this, in the MATLAB window, type the plot and 

grid on commands as shown below: 

 

>> plot(t,x,'k-',t,y,'r-');grid on 

 

As a result, the plot command creates a 2-D line plot in the input x(t) and 

output y(t) signals data versus the corresponding values in t, using the specified 

line style and colour, in MATLAB window called Figure 1. 

In example, the command plot(t,x,'k-',t,y,'r-') is set so that the transient 

response of the input signal x(t) is represented by a solid black line, and the 

transient response of the output signal y(t) by a dashed black line. You can 

select the line style and colour yourself, as described in Appendix A.1. 

To plot the all transient output responses of the Gain blocks y(t) when 

studying with the one input signal type x(t) together in Figure 1, you must type 

the hold on command and repeat the plot command again: 

 

>> hold on 

>> plot(t,x,'k-',t,y,'b-');grid on 

 

12. Label the transient responses of the input x(t) and output y(t) signals, 

the X and Y axis using  and  buttons on the Figure toolbox as shown in 

Figure A.1 of the Appendix A.2. 

For example: for the block diagram in Figure B.1 of the Appendix B 

shows simulation results (Figure B.2 of the Appendix B) when a unit step 

function is fed to the input. 

By analysing the results, you can see how this model works: an input 

signal equal to one, x = 1, is fed from the output of the Constant block to the 

input of the Gain block with transfer ratios K1 = 25, K2 = 50 and K3 = 100. The 

input signal equal to one is multiplied by the corresponding value of transfer 

ratio K. If K2 = 50, so the output signal will be equal to 50501 y . 
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Figure B.2 shows the X and Y axes and the transient responses of the input 

x(t) and output y(t) signals: 

– the transient response of the input signal x(t) is represented by the black 

solid line and described by the equation x(t) = 1(t); 

– the transient responses of the output signals y(t) are represented by the 

black dashed lines and described by corresponding equations y(t) = 25, y(t) = 50 

and y(t) = 100. 

– X-axis describes time t; 

– Y-axis describes input x and output y signals. 

13. Copy the Figure to the clipboard by clicking Edit → Copy Figure. 

14. Open a Word Document again and paste the Figure from the clipboard 

using the Edit →  Paste command from the menu or by clicking Paste  but-

ton on the toolbox in Word Document. 

15. Make a report (see Appendix B.1) and save it on disk or USB. 

16. Get the mark for your lab class from your teacher by answer-ing 

his/her control questions. 

 

1.3 Self-control questions 

1. What is Simulink? 

2. What subparts of the Simulink Library Browser are used in the lab 

class? 

3. What blocks does the block diagram consist in the lab class? 

4. How do you set the parameters for the blocks used in the lab class? 

5. Describe the operations on the blocks. 

6. What are the functions of the blocks in the Simulink/Sources library? 

7. How do you set the parameters for the blocks used in the Sim-

ulink/Sources library in the lab class? 

8. What do the plot, grid on and hold on commands mean? 

9. How is the created block diagram and simulation results moved to a 

Word document? 

10. Name and write down the equation of the input signals. 
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Lab class 2 

Study of time responses of typical dynamic control actions 

 

Objective of the work: 

– getting skills in creating block diagrams of typical dynamic control ac-

tions in Simulink; 

– studying the time responses of typical dynamic control actions; 

– studying the effect of changing the parameters of typical dynamic con-

trol actions transfer functions on the behavior of their time responses in 

MATLAB/Simulink. 

 

2.1 Theoretical part 

Typical dynamic control actions are control actions that are described by 

linear ordinary differential equations of the first or second order. 

The differential equation of the first-order typical dynamic control ac-

tions looks as: 

    







 tx

dt

dx
TKty

dt

dy
T 0 , (2.1) 

where x(t) – is the input signal; 

y(t) – is the output signal; 

T – is the derivative coefficient of the output signal y(t); 

T0 – is the derivative coefficient of the input signal x(t); 

K – is the transfer ratio of the typical dynamic control action. 

The differential equation of the second-order typical dynamic control 

actions looks as: 

    













 tx

dt

dx
T

dt

xd
TKty

dt

dy
T

dt

yd
T 002

2
2

02

2
2 22 , (2.2) 

where 0,  – are the damping ratio, which shows how quickly the oscillation 

process damps in the input and output signals respectively. 

These linear ordinary differential equations describe the dynamic behav-

iour of typical dynamic control actions. Linear ordinary differential equations 

can be solved using the Laplace transform method. To do this, all derivatives of 

the differential equation are replaced by a differential operator or a Laplace op-
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erator s (
dt

d
s  ) and the initial conditions are assumed to be zero. 

As a result, we obtain the transfer function of the typical dynamic con-

trol action as the ratio of the Laplace transform of the output signal y(s) to the 

Laplace transform of the input signal x(s) with the initial conditions as zero: 

 
 
 sx

sy
sW  . 

The basic typical dynamic control actions and their transfer functions W(s) 

are shown in Table 2.1. 

 

Table 2.1 – Transfer functions of typical first- and second-order dynamic 

control actions 

Name the dynamic control action 
Transfer function 

of the dynamic control action 

the proportional control action (P)   KsW   

the integral control action (І) 
 

sTs

K
sW




1
 

the derivative control action (D)   sTsW   

the first-order aperiodic control action 

(А-1) 
 

1


sT

K
sW  

the vibration control action (V) 
 

1222 


sTsT

K
sW , 

where  < 1 

the conservative control action (Con) 
 

122 


sT

K
sW , 

where  = 0 

the second-order aperiodic control action 

(А-2) 
  




12
1

22 sTsT

K
sW  

   
,

sTsT

K

11
21


  

where 11   
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Using the transfer function, you can get a transient at the output of the 

typical dynamic control action when input signals are fed to it. This allows you 

to evaluate the behavior of the typical dynamic control action in the time 

domain. 

In the lab class you will study dynamic properties of the typical dynamic 

control actions when the following input signals are fed to them: 

– the unit step function x(t) = 1(t) (see Figure 1.15); 

– the unit impulse function x(t) = (t) (see Figure 1.17). 

The dependence of the change in the output of the typical dynamic control 

action on time t, when a unit step function x(t) = 1(t) is fed to its input at zero 

initial conditions, is called the transient response h(t). 

The transient response h(t) is defined as the inverse Laplace transform. A 

function of a variable t is called an «original», and its Laplace transform is 

called an «image». The image of input signal     
s

sXtxL
1

 , the image of 

output signal            
 
s

sW
sXsWsYthLtyL  . So, the transient re-

sponse looks as: 

 








 

s

sW
Lth

)(
)( 1 . (2.3) 

The transient responses of the basic typical dynamic control actions h(t) 

are shown in Table 2.2. 

 

Table 2.2 – Transient responses of typical first- and second-order dynamic 

control actions 

Name the dynamic control action 

and transient response equation 

Transient response 

of the dynamic control action 

the proportional control action (P) 

   tKth 1  
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Continuation of the Table 2.2 

Name the dynamic control action 

and transient response equation 

Transient response 

of the dynamic control action 

the integral control action (І) 

tKth )(  

 

the derivative control action (D) 

 tTth )(  

 

the first-order aperiodic control action (А-1) 

















T

t

eKth 1)(  

 

the vibration control action (V) 

  




















  tteKth t sincos1 wh

ere 
T

21 
 , 

T


   

the conservative control action (Con) 

 






























 t

T
Kth

21
cos1  

 

the second-order aperiodic control 

action (А-2) 

  21

21

2

21

1 T

t

T

t

e
TT

TK
e

TT

TK
Kth












 , 

where 

12
1




T
T , 

12
2




T
T  
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The dependence of the change in the output signal of the typical dynamic 

control action on time t, when a unit impuls function x(t) = (t) is fed to its 

input, is called the impulse transient responses w(t). 

The impulse transient response w(t) is defined as the inverse Laplace 

transform. The image of input signal      1 sXtL , the image of output 

signal              sWsXsWsYtwLtyL  . So, the transient response 

looks as: 

 

 .)()( 1 sWLtw   (2.4) 

The impulse transient responses of the basic typical dynamic control ac-

tions w(t) are shown in Table 2.3. 

 

Table 2.3 – Impulse transient responses of typical first- and second-order 

dynamic control actions 

Name the dynamic control action and 

impulse transient response equation 

Impulse transient response 

of the dynamic control action 

the proportional control action (P) 

   tKtw   

 

 

the integral control action (І) 

Ktw )(  

 

 

the derivative control action (D) 

 
dt

td
Ttw


)(  

  

the first-order aperiodic control action 

(А-1) 

T

t

e
T

K
tw



)(  
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Continuation of the Table 2.3 

Name the dynamic control action and 

impulse transient response equation 

Impulse transient response 

of the dynamic control action 

the vibration control action (V) 

  te
T

K
tw t 


  sin

2
, 

where 
T

21 
 , 

T


  

 

the conservative control action (Con) 

 
















 t

TT

K
tw

21
sin  

 

the second-order aperiodic control ac-

tion (А-2) 

 




















21

21

T

t

T

t

ee
TT

K
tw  

 

 

From the definition of a unit impulse function   )(1)( tt , a ratio is es-

tablished between the transient response h(t) and the impulse transient response 

w(t), which looks as: 

 
)()( thtw 

          
 or        

t

dttwth

0

)()( . (2.5) 

The transient response h(t) and the impulse transient response w(t) are 

called time responses of typical dynamic control actions. 

 

2.2 Tasks 

1. Study the lecture on the topic «Time responses of typical dynamic con-

trol actions: transient responses and impulse transient responses». 

2. Based on the block diagram (see Figure 1.13), build a block diagram 
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when an unit step function x(t) = 1(t) and an unit impulse function x(t) = (t) are 

fed to its in Simulink (see Figure C.2,a of the Appendix C). 

3. Replace the Gain blocks by blocks of the typical first- and second-order 

dynamic control actions with their transfer functions W(s) one after the other 

according to Table 2.1. 

3.1. The first typical dynamic control action you study is the integral con-

trol action (I). This is described by the transfer function  
sTs

K
sW




1
 (see 

Table 2.1). It can be found in the Simulink/Continuous library. The Integrator 

block icon is shown in Figure 2.1,a. It integrates the input signal x(t) at zero ini-

tial conditions. 

In the lab class, to realise the transfer function  
sT

sW



1

, it is neces-

sary to locate the Integrator block after the Gain block and connect it together as 

shown in Figure 2.1,b. 

 

 
 

a b 

Figure 2.1 – Integrator block icon and 

block diagram for realising the Integral control action 

 

The time constant T of the transfer function  
sT

sW



1

 is set in three 

variants: T1, T2 and T3. You can take the time constants T1, T2 and T3 from Ta-

ble 2.4 for your variant N, where N is the variant number corresponding to the 

number in the student group list. 

Enter time coefficients T1, T2 and T3 in the Gain field of Block Parame-

ters: Gain as shown in Figure 2.1,b, for the corresponding Gain block. 

 

3.2. The second typical dynamic control action you study is the derivative 

control action (D). This is described by the transfer function   sTsW   (see 
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Table 2.1). It can be found in the Simulink/Continuous library. The Derivative 

block icon is shown in Figure 2.2,a. It differentiates the input signal x(t) by the 

current time t. 

In the lab class, to realise the transfer function   sTsW  , it is necessary 

to locate the Derivative block after the Gain block and connect it together as 

shown in Figure 2.2,b. 

 

 
 

a b 

Figure 2.2 – Derivative block icon and 

block diagram for realising the Derivative control action 

 

The time constant T of the transfer function   sTsW   is set in three 

variants: T1, T2 and T3. Take the time constants T1, T2 and T3 from Table 2.4 for 

your variant N. 

Enter time coefficients T1, T2 and T3 in the Gain field of Block Parame-

ters: Gain for the corresponding Gain block. 

 

3.3. The next typical dynamic control actions you study are: 

– the first-order aperiodic control action (А-1); 

– second-order aperiodic control action (А-2); 

– vibrational control action (V); 

– conservative control action (Con). 

These are described by transfer functions W(s) as shown in Table 2.1. In 

the general form their transfer functions are the ratio of the polynomials of the 

numerator of the m-th degree and the denominator of the n-th degree: 

 .
...

...

)(

)(
)(

01
1

1

01
1

1

asasasa

bsbsbsb

sX

sY
sW

n
n

n
n

m
m

m
m










  (2.6) 

In the lab class, you can realise transfer functions of typical first- and se-

cond-order dynamic control actions using the Transfer Fcn block. It can be 



 33 

found in the Simulink/Continuous library. The Transfer Fcn block icon is 

shown in Figure 2.3. 

In the Transfer Fcn block, the nu-

merator and denominator polynomials are 

only set by coefficients, which are entered 

through a space in decreasing degrees of 
 

 

Figure 2.3 – Transfer Fcn block icon 

the Laplace operator s, as shown in Figure 1.10. 

Pay attention! The order of the numerator polynomial degree m must be 

less or equal to the order of the denominator polynomial degree n ( nm  ). 

For example, to realise a transfer function for a second-order aperiodic 

сontrol action 
131,021,0

10

12
)(

2222 





sssTsT

K
sW , set the 

data in the Block Parameters: Transfer Fcn, as shown in Figure 2.4: 

 in the Numerator field, 

enter 10 in square brackets, [10], 

because K=10; 

 in the Denominator 

field, enter 0.12, 2·0.1·3 and 1 

through a space in square brack-

ets, [0.12   2·0.1·3   1], because: 

22 1,0T , 31,022 T . 

According to your variant 

N, take the transfer ratio K, time 

constants T1, T2 and T3, damping 

ratios ζ1 (for vibration control 

action), ζ2 (for second-order 

aperiodic control action) and ζ3 

(for conservative control action) 

from Table 2.4 and set them in 

the Block Parameter: Transfer  

 
Figure 2.4 – Setting data in the Transfer Fcn Block 

Fcn for the corresponding Transfer Fcn block, as shown in the example. 

So, the block diagram in Figure C.2,a of the Appendix C is created. 

 

4. Copy the created block diagram to the clipboard as described in the 
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Theoretical part: Copy and move model components to the clipboard. 

5. Open a Word Document and paste the created block diagram from the 

clipboard using the Edit →  Paste command from the menu or by clicking Paste 

 button on the toolbox in Word Document. 

6. Set the simulation parameters as described in the Theoretical part: 

Setting Simulation Parameters and running simulation. 

7. Save the created block diagram as described in the Theoretical part: 

Save the block diagram and script as a file. 

8. Obtain the transfer functions of the typical first- and second-order dy-

namic control actions from Table 2.1 using the code in Appendix C.2. 

9. Study the behaviour of the following typical dynamic control actions 

one after the other: 

– the integral control action (І); 

– the derivative control action (D); 

– the first-order aperiodic control action (A-1); 

– the second-order aperiodic control action (A-2); 

– vibrational control action (V); 

– conservative control action (Con) 

for given input signals x(t): 

– the unit step function x(t) = 1(t); 

– the unit impulse function x(t) = (t). 

The behaviour of the typical dynamic control actions listed above is stud-

ied at different values of time constants T1, T2, T3 and damping ratios ζ1, ζ2, ζ3. 

For this, switch the Transfer Fcn blocks one after the other using the Manual 

Switch block. 

Run simulation after each Transfer Fcn block switch by clicking Start 

Simuation  button on the toolbox. 

10. Plot the transient responses of the input x(t) and output y(t) signals in 

the same coordinate axes. For this, in the MATLAB window, type the plot and 

grid on commands as shown below: 

 

>> plot(t,x,'k-',t,y,'r-');grid on 
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To plot the all transient output responses of the Transfer Fcn blocks y(t) 

when studying with the one input signal type x(t) in the same coordinate axes, 

you must type the hold on command and repeat the plot command again: 

 

>> hold on 

>> plot(t,x,'k-',t,y,'b-');grid on 

 

11. Label the transient responses of the input x(t) and output y(t) signals, 

the X and Y axis using  and  buttons on the Figure toolbox as shown in 

Figure A.1 of the Appendix A.2. 

12. Copy the Figure to the clipboard by clicking Edit → Copy Figure. 

13. Open a Word Document again and paste the Figure from the clipboard 

using the Edit →  Paste command from the menu or by clicking Paste  but-

ton on the toolbox in Word Document. 

14. Make a report (see Appendix C) and save it on disk or USB. 

15. Get the mark for your lab class from your teacher by answer-ing 

his/her control questions. 

 

2.3 Self-control questions 

1. What is called a typical dynamic control action? Name the typical first- 

and second-order dynamic control actions? 

2. What responses are called time responses? What is called a transient re-

sponse h(t) and an impulse transient response w(t). 

3. How to determine the transient response h(t) on the transfer function? 

4. How to determine the impulse transient response w(t) on the transfer 

function? 

5. How to determine the impulse transient response w(t) of a dynamic 

control action by the transient response h(t)? 

6. Write down the transfer function and plot the time responses of the 

first-order typical dynamic control actions. 

7. Write down the transfer function and plot the time responses of the sec-

ond-order typical dynamic control actions. 

8. Assess the effect of changing the parameters of the dynamic control ac-

tions on their time responses. 
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Table 2.4 – Data of the typical dynamic control actions 

N 1 2 3 4 5 6 7 8 9 10 

К 10 15 20 25 30 35 40 45 50 10 

Т1 0,1 0,1 0,1 0,1 0,2 0,2 0,2 0,2 0,3 0,3 

Т2 1 1 1 1 1 1 1 1 1 1 

T3 1,5 2 2,5 3 3,5 4 4,5 5 1,5 2 

ζ1 0,3 0,4 0,5 0,6 0,7 0,3 0,4 0,5 0,6 0,7 

ζ2 1,0 1,1 1,2 1,3 1,4 1,5 1,6 1,7 1,8 1,0 

ζ3 0 0 0 0 0 0 0 0 0 0 

           

N 11 12 13 14 15 16 17 18 19 20 

К 15 20 25 30 35 40 45 50 10 15 

Т1 0,3 0,3 0,4 0,4 0,4 0,4 0,5 0,5 0,5 0,5 

Т2 1 1 1 1 1 1 1 1 1 1 

T3 2,5 3 3,5 4 4,5 5 2 2,5 3 3,5 

ζ1 0,3 0,4 0,5 0,6 0,7 0,3 0,4 0,5 0,6 0,7 

ζ2 1,1 1,2 1,3 1,4 1,5 1,6 1,7 1,8 1,0 1,1 

ζ3 0 0 0 0 0 0 0 0 0 0 

           

N 21 22 23 24 25 26 27 28 29 30 

К 20 25 30 35 40 45 50 10 15 10 

Т1 0,6 0,6 0,6 0,6 0,7 0,7 0,7 0,7 0,8 0,8 

Т2 1 1 1 1 1 1 1 1 1 1 

T3 4 4,5 5 2 2,5 3 3,5 4 4,5 5 

ζ1 0,3 0,4 0,5 0,6 0,7 0,3 0,4 0,5 0,6 0,7 

ζ2 1,2 1,3 1,4 1,5 1,6 1,7 1,8 1,0 1,1 1,2 

ζ3 0 0 0 0 0 0 0 0 0 0 
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Lab class 3 

Study of the frequency response of typical dynamic control actions 

 

Objective of the work: 

– getting skills in writing MATLAB script code that generates the transfer 

functions of the typical dynamic control actions; 

– studying the frequency response of typical dynamic control actions. 

 

3.1 Theoretical part 

The frequency response is a function that relates the output response to a 

sinusoidal input    tAtx  sininput  at frequency . 

If a sine wave of a certain frequency  is fed to the dynamic control ac-

tion, the output signal is also sine wave and has the same frequency , but with 

a different amplitude Аoutput (t) and phase shift 0360



T

t
: 

     tAty sinoutput , (3.1) 

where T – is period, sec. 

Figure 3.1 shows the sinusoidal input x(t) and output y(t) signals of a 

dynamic control action in steady-state. Here the output wave lags behind the in-

put wave by an offset angle. 

 

 

Figure 3.1 – The sinusoidal input x(t) and output y(t) signals of 

the dynamic control action in steady-state 
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For any dynamic control action, the ratio of the output wave amplitude to 

the input wave amplitude 
input

output

A

A
 and the phase shift between the waves of the 

output signal and the input signal φ depend only on the frequency ω. The ratio 

of the output wave amplitude and the input wave amplitude is described by the 

frequency transfer function   jH
A

A

input

output
. 

The frequency transfer function H(jω) is the ratio of the Fourier 

transform of the sinusoidal output signal to the Fourier transform of the 

sinusoidal input signal at zero initial conditions. 

The Fourier transform can be obtained from the Laplace transform by 

substitute the Laplace operator s in the transfer function W(s) with the complex 

number jω: 

    



js

sWjH . (3.2) 

The basic typical dynamic control actions and their frequency transfer 

functions H(j) are shown in Table 3.1. 

 

Table 3.1 – Frequency transfer functions of typical first- and second-order 

dynamic control actions 

Name the dynamic control action 
Frequency transfer functions 

of the dynamic control action 

the integral control action (І) 
 




K
jjH  

the derivative control action (D)    KjjH  

the first-order aperiodic 

control action (А-1) 
 

    11
22








T

TK
j

T

K
jH  

the vibration control action (V) and 

the second-order aperiodic control 

action (А-2) 

 
 

   

   2
222

2222

22

21

2

21

1













TT

TK
j

TT

TK
jH

 

the conservative control action (Con) 
 

 21 


T

K
jH  
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The frequency transfer function H(jω) is a complex number. Therefore, it 

will have real U(ω) and imaginary V(ω) parts: 

           jeHjVUjH , (3.3) 

where    
 

tA

tA
jHU






sin

sin
Re

input

output
 – is real part of the frequency 

transfer function H(jω); 

       jHjHV argIm  – is imaginary part of of the frequency 

transfer function H(jω); 

     jHH  – is the modulus of the vector H(jω) on the complex 

plane or the amplitude frequency response; 

     jH  – is the angle (argument) or phase of the vector H(jω) 

or the phase frequency response. 

The amplitude frequency response is the square root of the sum of the 

squares of the real and imaginary parts: 

      22
 VUjH . (3.4) 

The amplitude frequency response is built on the complex plane. The X-

axis indicates the frequency changes from zero to infinity (0 < ω < ∞), the Y-

axis the modulus (length) of the vector H(jω); 

The phase frequency response is the arctangent of the ratio of the imagi-

nary part of the frequency response to the real part of the frequency response. 

The phase frequency response is built on the complex plane. The X-axis 

indicates the frequency changes from zero to infinity (0 < ω < ∞), the Y-axis the 

angle φ(ω) (argument) or phase of the vector H(jω). 

Pay attention! The phase frequency response of the first-order dynamic 

control actions tends to 
2


  







 


2
 and is defined by the formula: 

  
 
 



U

V
arctg . (3.5) 

The phase frequency response of the second-order dynamic control 

actions tends to      and is defined by the formula: 

  
 
 



U

V
arctg . (3.6) 
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When the frequency ω changes from 0 to infinity, the vector of the fre-

quency transfer function  jH  draws around a curve called amplitude-phase 

frequency response. 

The amplitude-phase frequency response represents is the geometrical 

location of the ends of the vectors or hodograph corresponding to the frequency 

response H(jω) when the frequency changes from zero to infinity (0 < ω < ∞). 

The amplitude-phase frequency response is built on the complex plane. The X-

axis indicates the real part of the transfer function U(ω), the Y-axis the imagi-

nary part of the transfer function V(ω). In essence, such a graph combines in 

one plane the amplitude frequency H(ω) and phase frequency φ(ω) responses. 

Pay attention! The amplitude-phase frequency response of the first-

order dynamic control actions is located in the fourth quadrant of the complex 

plane. 

The amplitude-phase frequency response of the second-order dynamic 

control actions is located in the third and fourth quadrants of the complex 

plane. 

The real frequency response U(ω) is the even frequency transfer func-

tion H(jω). The X-axis indicates the frequency changes from zero to infinity 

(0 < ω < ∞), the Y-axis indicates the real part of the frequency transfer function 

U(ω). 

The imaginary frequency response V(ω) is an uneven frequency transfer 

function H(jω). The X-axis indicates the frequency changes from zero to infinity 

(0 < ω < ∞), the Y-axis indicates the imaginary part of the frequency transfer 

function V(ω). 

In practice, the amplitude frequency H(ω) and phase frequency φ(ω) re-

sponses are often represented on a logarithmic scale: 

– the logarithmic amplitude frequency response L(ω) represent is the 

amplitude frequency response in which the amplitude of the frequency response 

H(jω) is expressed in decibels, dB, and the frequency is expressed in logarith-

mic scale lg(ω); 

     HL lg20 ; (3.7) 

– the logarithmic phase frequency response φ(ω) represent is the phase 

frequency response in which the phase is expressed in degrees and the frequen-

cy is expressed in logarithmic scale lg(ω). 
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In the lab class, to build the frequency responses for typical dynamic con-

trol action from Table 3.1, it is more convenient to use the M-files Edi-

tor/MATLAB (script-files/MATLAB). An M-file or script file, is a simple 

text file, in which MATLAB commands are placed. When the file is run, 

MATLAB reads the commands all at once or in parts. All M-file names must 

end with the extension «name.m». 

 

3.2 Tasks 

1. Study the lecture on the topic «Frequency responses of typical dynamic 

control actions». 

2. Run MATLAB. 

3. To write a new script in MATLAB you need to open M-file Editor 

window. For this, select File  New  M-file command from the menu or 

click New M-file  button on the MATLAB toolbox. It opens a new Untitled 

window, as shown in Figure 3.2. 

 

 
Figure 3.2 – M-file Editor Window 

 

4. After opening the Untitled window in the M-file Editor window, code 

can be written to build the frequency responses of typical dynamic control ac-

tions with the transfer functions W(s) from Table 2.1. 

Pay attention! The code below are only for building the frequency re-

sponses of the first-order dynamic control actions: 
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clc; Clear the Command Window 

clear all; Removal of variables and functions from 

clipboard 

w=[0:0.1:100]; Setting the frequency range  from 0 to 100 

in step t = 0,1. 

Pay attention! The frequency range can be 

any 

s=j.*w; Substitute the Laplace operator s with the 

complex number j: s = j 

K = your variant data; Set the transfer ratio data of the typical 

dynamic control action K from Table 2.4, 

according to your variant N 

T = your variant data; Set the time constant data of typical 

dynamic control action T1 from Table 2.4, 

according to your variant N 

W = the transfer function of 

the typical dynamic control 

action you are studying 

 

 

 

For example, the transfer 

function of a first order ape-

riodic control action (A-1) in 

the general form is written as 

follows: 

W = K./(T.*s+1) 

Write down the transfer function in the 

general form of a typical dynamic control 

action W(s) you are studying. As a result of 

the substitute s = j, the transfer function in 

the Laplace transforms W(s) is convert into 

the frequency transfer function H(j). 

Pay attention! The transfer functions of the 

typical dynamic control actions can be 

found in Table 2.1. 

According to MATLAB syntax, put a dot 

before the operations of division (/), multi-

plication (*) and exponentiation (^). 

U = real(W); 

V = imag(W); 

Select the real U() and imaginary V() 

parts from the frequency transfer function 

H(j). See formula 3.3 

H = sqrt(U.^2+V.^2); Amplitude calculation of frequency transfer 

function H(j). See formula 3.4 
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Continuation of the code 
fi = atan(V./U).*(180./pi) Phase calculation of frequency transfer 

function H(j). See formula 3.5 

figure;plot(U,V);grid on Building the amplitude-phase frequency 

response in a separate figure window. 

Pay attantion! The amplitude-phase 

frequency response of a first order dy-

namic control actions is located in the 

fourth quadrant of the complex plane 

figure;plot(w,H);grid on Building the amplitude frequency 

response H() in a separate figure 

window 

figure;plot(w,fi);grid on Building of the phase frequency re-

sponse () in a separate figure window 

figure; bode([K],[denominator 

coefficients only]); grid on 

 

 

 

For example, the bode command 

for the transfer function of the 

first order aperiodic control 

action (A-1)  
1


sT

K
sW  is 

written as follows: 

bode([K],[T    1]), 

where T – coefficient before La-

place operator s of the first order, 

1 – free coefficient. 

Building the logarithmic amplitude fre-

quency response L() and the logarith-

mic phase frequency response () un-

der each other in a separate figure win-

dow. 

Pay attention! Enter denominator 

coefficients ordered by decreasing 

Laplace operator s (see Figure 2.4). 

By default, MATLAB clears the figure 

before each plot command. 

Using the figure command to open a 

new figure window. 

Command grid on displays the major 

grid lines for the current axes 

 

Pay attention! The code for building the frequency responses of the sec-

ond-order dynamic control actions are shown in Appendix C. 

5. Save the written code as described in the Theoretical part: Save the 

block diagram and script as a file. 
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6. Run the M-file Editor. Click the Run  button on the toolbox and 

build the frequency responses. 

7. Label the X and Y axis using  and  buttons on the Figure toolbox 

as shown in Figure С.1 of the Appendix С. 

8. Copy the Figure to the clipboard by clicking Edit → Copy Figure. 

9. Open a Word Document and paste the Figure from the clipboard using 

the Edit → Paste command from the menu or by clicking Paste  button on 

the toolbox in Word Document. 

10. Make a report (see Appendix C) and save it on disk or USB. 

11. Get the mark for your lab class from your teacher by answering his/her 

control questions. 

 

3.3 Self-control questions 

1. What are the frequency responses? 

2. How to determine the frequency responses having a control action 

transfer function? 

3. What response is called Amplitude-phase frequency response and how 

to build it? 

4. What responses are called Real U() and Imaginary V() frequency re-

sponses and how to build them? 

5. How to determine the amplitude and argument from the amplitude-

phase frequency response? 

6. What responses are called Logarithmic amplitude-frequency response 

L() and the Logarithmic phase-frequency response () and how to build 

them? 

7. What are the units of measurement taken on the coordinate axes of 

Logarithmic amplitude-frequency response L() and the Logarithmic phase-

frequency response ()? 

8. How will the logarithmic amplitude-frequency and logarithmic phase-

frequency response control actions change if the transfer ratio increases 100 

times? 

9. Which typical control action does not change the phase of a harmonic 

signal of any frequency? 
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APPENDIXES 

 

APPENDIX А 

Formatting, adding labels, adjusting colours on plots for report 

 

A.1 Create 2-D line plot 

The functions y = f(x) are used in mathematical calculations as well as in 

computer simulations and are plotted as a graph in a coordinate system: X-axis 

and Y-axis. The resulting set of points are connected by straight line sections. In 

MATLAB they create a one-dimensional (1-D) array matrix. 

To create 2-D line plot, use the plot command: 

• plot (Х,Y) – creates a 2-D line plot of the data in Y versus the corre-

sponding values in X. 

If X and Y are both vectors, then they must have equal length. The plot 

function plots Y versus X. 

If X and Y are both matrices, then they must have equal size. The plot 

function plots columns of Y versus columns of X. 

If one of X or Y is a vector and the other is a matrix, then the matrix must 

have dimensions such that one of its dimensions equals the vector length. If the 

number of matrix rows equals the vector length, then the plot function plots 

each matrix column versus the vector. If the number of matrix columns equals 

the vector length, then the function plots each matrix row versus the vector. If 

the matrix is square, then the function plots each column versus the vector. 

• plot(X1,Y1,'color_type'...,Xn,Yn,'color_type') plots more than one 

pair of X, Y using the same axes for all plots. Each plots is given a colour and 

line style, which you can select from Table A.1. 

 

Table A.1 – Colour and line style to identify the plot 

Line color Line style 

'r' red 'g' green '–' solid line 

'b' blue 'm' purple ':' double dotted line 

'k' black 'у' yellow '-.' dotted line 

'c' cyan 'w' white '--' dashed 
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A.2 Adding labels and axes to a figure 

To pass on important information about the plot you need to make labels. 

Click Insert Text  button on the Figure/Simulink toolbox. 

Left-click on the desired location in the figure and a text label cursor will 

appear. The text labels are written in English. 

As an example, Figure A.1 shows a block diagram and the transient re-

sponses of the input x(t) and output y(t) signals using the plot command: 

 

>> plot(t,x,'k-',t,y,'k--.');grid on 

 

The plot command describes that the plot of the input signal x(t) is indi-

cated by a solid black line and the plot of the output signal y(t) is indicated by a 

dashed black line. 

The grid on command displays the axis grid lines. 

Axis labels have been added to the Figure: the X-axis describes the time t, 

the Y-axis describes the input x and output y signals. 

To draw arrows showing the direction of the X- and Y- axes in Figure, 

click Insert Arrow  button on the Figure/Simulink toolbox. The cursor 

changes to a cross (+). Press and hold the left mouse button and drag the cross 

from start to end limits of the X-axis or Y-axis, as shown in Figure A.1,b. 

 

 

 
а b 

Figure А.1 – Block diagram and transient responses of input x(t) and output y(t) 

signals in the same axes 
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y=3sint 

The end of the APPENDIX A 
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APPENDIX B 

Report fragment of the lab class 1 

Basic knowledge of MATLAB and Simulink. Building simple models 

 

B.1 Report content 

1. Title page (see Appendix E) 

2. Objective of the work 

3. Results: 

3.1 Block diagram for studying the Gain block with different input signals 

3.2 Transient responses of the input x(t) and output y(t) signals in the same 

coordinate axes in study the behaviour of the Gain block with different values 

of transfer ratios K to the given input signals x(t): 

– the unit step function; 

– the linearly increasing signal; 

– the unit impulse function; 

– the sinusoidal signal. 

4. Conclusion 

 

B.2 Example of report design 

 

 
Figure B.1 – Block diagram for studying the Gain block with different input signals 
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Figure B.2 – Transient responses of the Gain block at different values 

of the transfer ratio K when a unit step function x(t)=1(t) is fed to the input 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The end of the APPENDIX B 
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APPENDIX C 

Report fragment of the lab class 2 

Study of time responses of typical dynamic control actions 

 

C.1 Report content 

1. Title page (see Appendix E) 

2. Objective of the work 

3. Results of studying the following typical dynamic control actions: 

– the integral control action (І); 

– the derivative control action (D); 

– the first-order aperiodic control action (A-1); 

– the second-order aperiodic control action (A-2); 

– vibrational control action (V); 

– conservative control action (Con): 

3.1 Block diagram for studying the behaviour of typical first- and second-

order dynamic control actions for given input signals x(t): 

– the unit step function x(t) = 1(t); 

– the unit impulse function x(t) = (t). 

3.2 Transfer functions of the typical first- and second-order dynamic con-

trol actions. 

3.3 Transient responses of the input x(t) and output y(t) signals in the same 

axes in study the behaviour of the typical first- and second-order dynamic con-

trol actions. 

4. Conclusion 

 

C.2 Code for transfer functions of typical first- and second-order 

dynamic control actions 

num=[K] – this is the numerator of the transfer function in the 

Laplace transform W(s) from Table 2.1. Take numeri-

cal data from Table 2.4 

den=[a2   a1   a0] – this is the denominator of the transfer function in the 

Laplace transform W(s) from Table 2.1. Take numeri-

cal data from Table 2.4 

sys=tf(num,den) – is the command to obtain the transfer function W(s) 

as the ratio of the numerator to the denominator 
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C.3 Example of report design 

 

 
Figure C.1 – Block diagram for studying the Gain block with different input signals 
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Figure C.2 – Transient responses of the first order aperiodic control action at different 

values of the time constant T when a unit step function x(t)=1(t) is fed to the input 

 

 

The end of the APPENDIX C 
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APPENDIX D 

Report fragment of the lab class 3 

Study of frequency responses of typical dynamic control actions 

 

D.1 Report content 

1. Title page (see Appendix E) 

2. Objective of the work 

3. Results of studying the following typical dynamic control actions: 

– the integral control action (І); 

– the derivative control action (D); 

– the first-order aperiodic control action (A-1); 

– the second-order aperiodic control action (A-2); 

– vibrational control action (V); 

– conservative control action (Con): 

3.1 Code for building the frequency responses of typical first- and second-

order dynamic control actions. 

3.2 Transfer functions of the typical first- and second-order dynamic con-

trol actions. 

3.3 Frequency responses of the typical first- and second-order dynamic 

control actions. 

4. Conclusion 

 

D.2 M-file to build frequency responses of the typical second-order 

dynamic control actions 

As an example, here are the code for building the frequency responses of 

the vibrational control action described by a transfer function: 

 
11,001,0

100

12 222 





sssTsT

K
sW

 
 

clc; Clear the Command Window 

clear all; Removal of variables and functions from clipboard 

K = 100; Enter the transfer ratio data K = 100 from Table 2.1 

T = 0.1; Enter the time constant data from Table 2.1 or calculate 

using the formula: 1,001,02  TT  
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Continuation 

ksi=0.5; Enter the damping ratio data from 

Table 2.1 or calculate using the 

formula: 

1,02  T  

1,01,02   

1,02,0   

5,0
2,0

1,0
  

w1=[0:0.1:(1/T-0.1)]; 

w2=[1/T:0.1:100]; 

Setting the frequency range  from 

0 to 100 in step t = 0.1. 

Pay attention! The frequency range 

 can be any. 

The frequency range  for the sec-

ond order control actions is set be-

fore 
T

1
  and after it, as the am-

plitude-phase frequency response is 

located in the third and fourth quad-

rants of the complex plane. The fre-

quency between the third and fourth 

quadrant is 
T

1
 . Therefore, 

frequency range w1, if 
T

1
 ; 

frequency range w2, if 
T

1
  

s1=j*w1; 

s2=j*w2; 

Substitute the Laplace operator s 

with the complex number j: 

for w1 will be s1; 

for w2 will be s2 

W1=K./(T.^2.*s1.^2+2.*ksi.*T.*s1+1); 

W2=K./(T.^2.*s2.^2+2.*ksi.*T.*s2+1); 

Write down the transfer function in 

the general form of the vibrational 

control action: 

 
1222 


sTsT

K
sW  

for s1 will be W1; 

for s2 will be W2 

Continuation of the APPENDIX D 
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Continuation 
U1=real(W1); 

U2=real(W2); 

Select the real U() part from the fre-

quency transfer function H(j), accord-

ing to formula 3.3: 

for W1 will be U1; 

for W2 will be U2 

V1=imag(W1); 

V2=imag(W2); 

Select the imaginary V() part from the 

frequency transfer function H(j), ac-

cording to formula 3.3: 

for W1 will be V1; 

for W2 will be V2 

H1=sqrt(U1.^2+V1.^2); 

H2=sqrt(U2.^2+V2.^2); 

Amplitude calculation of frequency 

transfer function H(j), accoding to for-

mula 3.4: 

for U1 and V1 will be H1; 

for U2 and V2 will be H2 

fi1=atan(V1./U1)*(180/pi); 

fi2=(-pi+atan(V2./U2))*(180/pi); 

Phase calculation of frequency transfer 

function H(j), accoding to formula 3.6: 

for U1 and V1 will be fi1 if 
T

1
 ; 

for U2 and V2 will be fi2 if 
T

1
  

figure;plot(U1,V1,’r’); hold on; 

plot(U2,V2,'b'); grid on; 

Building the amplitude-phase frequency 

response in a separate figure window  

Pay attention! Amplitude-phase fre-

quency response of second order dynam-

ic control actions is located in the third 

and fourth quadrants of the complex 

plane 

figure;plot(w1,H1,’r’); hold on; 

plot(w2,H2,'b') ;grid on 

Building the amplitude frequency 

response H() in a separate figure 

window 

figure;plot(w1,fi1,'r'); hold on; 

plot(w2,fi2,'b'); grid on; 

Building of the phase frequency response 

() in a separate figure window 

figure;bode([K],[T^2 2*ksi*T 1]); 

grid on 

Building the logarithmic amplitude fre-

quency response L() and the logarith-

mic phase frequency response () un-

der each other in a separate figure win-

dow 

Continuation of the APPENDIX D 
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D.3 Simulation results 

а) Amplitude-phase frequency response b) Amplitude frequency response

c) Phase frequency response d) Logarithmic amplitude-frequency re-

sponse L() and the Logarithmic phase-

frequency response () 

Figure D.1 – Frequency responses of the Vibrational control action 

The end of the APPENDIX D 
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